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 Introduction 
Thank you for purchasing the Korg microKORG XL+ synthesizer/vocoder. In order to take full advantage 
of your new instrument, please read this manual and use the product as directed. 
 

What is microKORG XL+ Sound Editor? 
microKORG XL+ Sound Editor is software that takes advantage of your computer’s large screen to let 
you edit and manage the microKORG XL+’s programs and global data with ease and convenience. 

 

Caution 

 Do not disconnect the microKORG XL+ or power-off the microKORG XL+ while microKORG XL+ 
Sound Editor is running. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 
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Operating requirements 

Windows 

Computer Computer that has a USB port and satisfies the requirements for running 
Microsoft Windows XP/Vista/7. 

Operating system Windows XP SP3 (32bit), or Windows Vista SP2 (32bit, 64bit), or Windows 7 
SP1 (32bit, 64bit) 

 

Mac OS X 

Computer Apple Macintosh computer with an Intel processor that has a USB port and 
satisfies the requirements for running Mac OS X. 

Operating system Mac OS X 10.5 or later 
 

 Full functionality is not guaranteed with all computers that satisfy these system requirements. 

 

 Installation 

Installation for Windows users 
Proceed as follows to install the software in Windows. 
1. Double-click “Setup_E.exe” to start the installation process. 
2. The microKORG XL+ Sound Editor Installer screen will appear. Follow the on-screen directions to 

install the software. 
 

Installation for Mac OS X users 
Proceed as follows to install the software in Mac OS X. 
1. Copy the “microKORG XL+ Editor” folder to the “Applications” folder. 
 

 Quick start 

Settings on the microKORG XL+ 
In order to use microKORG XL+ Sound Editor, follow the procedure below to make the necessary 
settings on the microKORG XL+. 
1. Set the [KNOB FUNCTION SELECT] dial to “FULL EDIT,” and use knob [1] to select the 

“GLOBAL” page. Use knob [2] to select “PROTECT,” and set knob [3] to “OFF.” 
2. Use knob [1] to select “MIDI FLT” page. Use knob [2] to select “SYS EX”, and set knob [3] to 

“ENABLE”. 
 

Settings in microKORG XL+ Sound Editor 

 In order to use microKORG XL+ Sound Editor via a USB connection, you must download the Korg 
USB-MIDI Driver from the Korg website and install it as directed by the accompanying 
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documentation. (http://www.korg.com/) 

1. Using a USB cable, connect the microKORG XL+ to your computer, and power-on the microKORG 
XL+. 

2. Move to the ”microKORG XL+” folder, and start up “microKORG XL+ Sound Editor.” 
Windows The "microKORG XL+" folder is located in the taskbar's "Start" - "All Programs" - 

"KORG." 
Mac OS X The "microKORG XL+" folder is located in the "Applications" folder. 

3. The library window will open automatically, and all data will be received from the microKORG XL+. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 

 

Editing a program 
Go ahead and try editing a program in microKORG XL+ Sound Editor. In the Library window, click the 
[PROGRAM] button to access the program page. From the program list in the Program page, select the 
program that you want to edit and click the [EDIT] button to open the Program Edit window. Use the 
knobs and buttons to edit the sound. For details on how to operate the knobs and buttons, refer to “Basic 
operations in the editor windows.”  
 

Writing a program to the microKORG XL+ 
Programs you’ve edited in microKORG XL+ Sound Editor are not written into the microKORG XL+; 
you’ll need to transmit the programs from microKORG XL+ Sound Editor each time you want to play 
them. It’s a good idea to transmit the programs from microKORG XL+ Sound Editor to the microKORG 
XL+ so that you don’t have to transmit them each time. In the Library window, click the [PROGRAM] 
button to access the Program page. From the “Communication” menu, choose “Write all data.” A dialog 
box will ask you to confirm the Write operation, so click [OK]. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 

 When you execute this operation, all 128 programs of the microKORG XL+ will be overwritten 
(replaced) by the programs from microKORG XL+ Sound Editor. If you want to keep the programs 
currently in the microKORG XL+, you must back them up beforehand. 
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 Windows and functions in microKORG XL+ Sound Editor 

This section provides a brief explanation of the functionality in each window of microKORG XL+ Sound 
Editor. 

 For details on each parameter, refer to the owner’s manual included with this document. 

 

Library window 
In the Library window you can manage programs and edit global data. 

 

The Library window is divided into the following two pages. To move between pages, click the page 
select buttons located at the top of the screen. 

Program page 

In the Program page you can select a program to edit, transmit and receive programs to or from the 

microKORG XL+, edit the program name or comment, and copy or rearrange programs. (→ p.15 

“Program management”) 

Global page 

In the Global page you can edit global data, and transmit and receive global data to or from the 

microKORG XL+. (→ p.20 “Global data management”) 
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Program edit window 
Here you can make settings that affect the entire program, such as the program name and the voice mode. 
From this window you can also open edit windows for Synth or Arpeggiator settings. 

 

[SYNTH EDIT] button 

Opens the Synth Edit window for each timbre. 

[EQ EDIT] button 

Opens the Timbre EQ Edit window for each timbre. 

Arpeggiator [EDIT] button 

Opens the Arpeggiator Edit window. 

Vocoder [EDIT] button 

Opens the Vocoder Edit window. 

Master Effect [EDIT] button 

Opens the Master Effect Edit window. 

Copying or exchanging parameters 

The drag mark  for the arpeggiator, vocoder, and master effect can be dragged and dropped to copy 
the parameters to a different program. The drag mark  for the timbre parameters can be dragged and 
dropped to exchange timbres 1 and 2. You can copy the timbre parameters by dragging and dropping 
while you hold down the [Ctrl] key (Windows) or the [option] key (Mac OS X). 
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Synth Edit window 
Here you can edit each timbre’s synth parameters such as oscillator, filter, and amp. 

 

[RANDOMIZE] button 

This sets the synth parameters to random values. 
 

Timbre EQ Edit window 
Here you can edit each timbre’s equalizer. 
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Arpeggiator Edit window 
Here you can select the arpeggiator’s arpeggio type, and make settings for each step. 

 

Master Effect Edit window 
Here you can select the effect type for the master effects, and edit the various parameters. 

 

Copying or exchanging parameters 

The drag mark  for master effect 1 and 2 can be dragged and dropped to exchange master effects 1 
and 2. You can copy the master effect parameters by dragging and dropping while you hold down the 
[Ctrl] key (Windows) or the [option] key (Mac OS X). 
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Vocoder Edit window 
Here you can edit the vocoder parameters. 

 

Log window 
This window displays the times when files were saved/loaded, the history of communication with the 
microKORG XL+, the accessed content, and error information. 

 

MIDI Monitor window 
This window displays the MIDI messages transmitted by microKORG XL+ Sound Editor and the MIDI 
messages received from the microKORG XL+. 
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 Basic operations in the editor windows 
Here’s how to operate the knobs and switches shown in the edit windows, and how to edit the parameters.  

Knobs 
Move the mouse pointer to the desired knob. The operation of the knobs will depend on the System 

setting “Knob Operation” (→ p.22 “Preference settings”). 

 You can adjust the value more finely by dragging while you hold down your computer’s [Shift] key. 

When “Knob Operation” is set to Circular 

Move the mouse pointer to the knob index (the mark that indicates the value), 
and edit the value by dragging the knob in a circle as though you were turning it. 
You can also jump immediately to a desired value by clicking the corresponding 
location.  

 

When “Knob Operation” is set to Relative Circular 

Edit the value by dragging the knob in a circle as though you were turning it. You 
cannot edit the value by clicking, as you can with the “Circular” setting. 

 
 

When “Knob Operation” is set to Linear 

Drag upward to turn the knob right (clockwise). Drag downward to turn the knob 
left (counter-clockwise). 

 
 

Sliders 
Move the mouse pointer to the desired slider, and drag it up or down. You can 
also edit the value by moving the mouse pointer to the desired parameter and 
moving the mouse wheel. 

 You can adjust the value more finely by dragging while you hold down your 
computer’s [Shift] key. 
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Switches and buttons 
Move the mouse pointer to the desired switch or button, and click. 

 
 

Parameters 

Parameters that you set by dragging 

Move the mouse pointer to the desired parameter. Drag upward to increase the 
value, or downward to decrease the value. You can also edit the value by moving 
the mouse pointer to the desired parameter and moving the mouse wheel. 

 You can adjust the value more finely by dragging while you hold down your 
computer’s [Shift] key. 

  
 

Parameters that you set from a popup menu 

A menu will appear when you click the desired parameter. From the 
menu, choose the desired value. You can also specify a value by moving 
the mouse pointer to the desired parameter and moving the mouse wheel.
 

 

Dragging and dropping 
The drag marks  in the edit screens allow you to copy or exchange parameters by dragging and 
dropping. You can exchange timbres or master effects, or copy parameters to a different program. 
 

Renaming 
You can rename a program (edit its name). When you’ve edited a program, it’s helpful to assign a name 
that reflects the sound of that program. When you double-click the program name, it will be highlighted, 
and can be edited. Type the desired name from your computer keyboard, and press the [Enter] key to 
complete the operation. If you decide not to rename the program, press your computer’s [Esc] key, or 
click the mouse on some other location; the program name will revert to its original state. 
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 Library management 

Screen items and their function 

 

[PROGRAM] button 

This displays the Program page. 

[GLOBAL] button 

This displays the Global page. 
 

Loading library data 
From the menu, choose “File”-”Open” to access the “Open” dialog box. Select the desired library data 
file and click the [Open] button. A new library window will open, and the library data will be loaded. 
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Saving library data 
From the “File” menu, choose “Save”; the currently-open library data file will be saved by overwriting it 
onto the existing version of that file. If the file is new, the “Save As” dialog box will appear. Specify the 
location in which you want to save the file, enter the desired file name, and click the [Save] button to save 
the library data. 
 

Copying library data 
You can copy program or global data to another library file. Drag the [PROGRAM] button or [GLOBAL] 
button and drop it on the [PROGRAM] or [GLOBAL] button of the desired copy-destination library 
window. 
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 Program management 

Screen items and their function 

 

Program name 

This indicates the name of the currently selected program. 

[EDIT] button 

This opens the Edit screen for the currently selected program. 

[RECEIVE] button 

This loads the program currently selected on the microKORG XL+ into the program that’s selected in the 
program list. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 
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[TRANSMIT] button 

This transmits the program currently selected in the program list to the microKORG XL+. The program 
will not be written into the microKORG XL+ by this operation. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 

[AUTO DUMP] button 

This turns the Auto Dump function on/off. If the Auto Dump function is on, selecting a program in the 
program list will automatically transmit that program to the microKORG XL+. 

[INFO] button 

This displays a dialog box that lets you edit the name or comment of the currently selected program. 

[COLUMN] button 

This switches the contents shown in the program list. 

[ALL] button 

This makes the program list show all 128 programs. 

[BANK] button 

This makes the program list show 64 programs (organized by bank) at a time. Fewer programs can be 
viewed simultaneously, but more information for each program will be visible. 

Program list 

This shows the currently loaded 128 programs. You can use the [COLUMN] button, [ALL] button, and 
[BANK] button to switch the displayed content. To select the program you want to edit, click a program 
in the list. Click the page select tabs to switch pages. 

Page select tabs 

The 128 programs are shown in two pages, organized by bank. Click these tabs to switch between pages. 
 

Receiving programs from the microKORG XL+ 
From the "Communication" menu, choose "Receive all programs" to load all programs from the 
microKORG XL+ into the program list. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 

 

Writing programs to the microKORG XL+ 
From the "Communication" menu, choose "Write all programs" to transmit all programs in the program 
list into the microKORG XL+ and write them into memory. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 
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Selecting a program 
Click a program shown in the program list to select it. You can also select a program by using your 
computer's cursor keys. You can select multiple programs by clicking while you hold down the [Ctrl] key 
(Windows) or [command] key (Mac OS X). You can select a contiguous range of programs by clicking 
while you hold down the [Shift] key. 
 

Moving a program 
You can move a program to a different location. Simply drag and drop the selected program onto the 
desired location. 

 

You can also move a program to a page that is not currently displayed. Drag the program to the page 
select tab of the desired destination page; the page will switch, and you can then drop the program onto 
the desired location in the newly displayed page. 
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Exchanging programs 
You can exchange the location of two programs by dragging and dropping one of the two programs while 
holding down the [Alt] key (Windows) or [command] key (Mac OS X). As when moving a program, you 
can exchange programs located in different pages by dragging one of the programs to the page select tab 
of the other page. 
 

Copying a program 

Copying a program by dragging and dropping 

To copy a program, drag the selected program and drop it onto the desired copy-destination while holding 
down the [Ctrl] key (Windows) or [option] key (Mac OS X). The program formerly at that destination 
will be overwritten. As when moving or exchanging programs, you can copy a program to a different 
page by dragging the program to a page select tab. 

Copying a program via the menu 

1. Select the copy-source program, and from the "Edit" menu choose "Copy." 
2. Select the copy-destination program, and from the "Edit" menu choose "Paste." A duplicate program 

will be overwritten onto the copy-destination. 
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Editing program information 
When you select a program and click the [INFO] button, the program information editing dialog box will 
appear. Edit the program name or comment, and click the [OK] button. If you decide to cancel the 
changes you made, click the [Cancel] button. 

 "Creator" and "Comment" information is not written into the microKORG XL+. If a program 
containing "Creator" and "Comment" data is written to the microKORG XL+ and then received back 
into microKORG XL+ Sound Editor, the "Creator" and "Comment" data will be lost. 

 

Initializing a program 
Select the program, and from the "Edit" menu, choose "Initialize." That program will be initialized to the 
initial program. 
 

Saving a program to a file 
You can save the selected program to your computer as a program data file. Select the program that you 
want to save, right-click (in Mac OS X, [control]-click) to display the popup menu, and choose "Save" to 
access the "Save program" dialog box. Specify the desired save location, enter a file name, and click the 
[Save] button. 
 

Loading a program from a file 
Select the program into which you want to load the file, right-click (in Mac OS X, [control]-click) to 
display the popup menu, and choose "Open" to access the "Load program" dialog box. Select the program 
data file that you want to load, and click the [Open] button. 
 

Restoring a program 
You can restore the selected program to the state in which it was prior to editing (i.e., the state saved in 
the file). From the "Edit" menu, choose "Revert to saved data," and the selected program will be restored 
to the state prior to editing. 
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 Global data management 

Screen items and their function 

 

[RECEIVE] button 

This loads the microKORG XL+'s global data into microKORG XL+ Sound Editor. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 

[WRITE] button 

This transmits the global data from microKORG XL+ Sound Editor to the microKORG XL+ and writes 
it. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 

[LOAD] button 

This loads global data from a global data file saved on your computer. 
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[SAVE] button 

This saves global data to your computer as a global data file. 

Page select tabs 

The global data is divided into several pages. Click these tabs to switch pages. 
 

Receiving global data from the microKORG XL+ 
When you click the [RECEIVE] button or choose the "Communication" menu item "Receive global 
data," the global data from the microKORG XL+ will be received into microKORG XL+ Sound Editor. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 

 

Writing global data to the microKORG XL+ 
When you click the [WRITE] button or choose the "Communication" menu item "Write global data," the 
global data in microKORG XL+ Sound Editor will be transmitted to the microKORG XL+ and written. 

 Do not operate the microKORG XL+ or microKORG XL+ Sound Editor while data is being 
transmitted or received. 

 

Saving global data to a file 
You can save global to your computer as a file. Click the [SAVE] button to access the "Save global data" 
dialog box. Specify the save-location, enter a file name, and click the [Save] button. 
 

Loading global data from a file 
Click the [LOAD] button to access the "Load global data" dialog box. Select a global data file and click 
the [Open]. 
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 Preference settings 
From the Options menu, choose "Preferences..." to open the Preferences dialog box. 

 

MIDI ports 

Find devices automatically 

If this setting is on, the port to which the microKORG XL+ is connected will be found and specified 
automatically. If this is off, use the MIDI IN/OUT port settings to specify the ports to which the 
microKORG XL+ is connected. 

MIDI IN 

This specifies the MIDI IN port to which the microKORG XL+ is connected. You should normally set 
this to "microKORG XL+ 1 KBD/KNOB" in Windows, or "microKORG XL+ - KBD/KNOB" in Mac OS 
X. 

MIDI OUT 

This specifies the MIDI OUT port to which the microKORG XL+ is connected. You should normally set 
this to "microKORG XL+ 1 Sound" in Windows, or "microKORG XL+ - Sound" in Mac OS X. 
 

Operations 

Knob operation 

This specifies how the knobs shown in the editing screens will operate. For details on each type of 
operation, refer to "Basic operation in the editor windows." 
For details on each type of operation, refer to "Basic operations in the editor windows." 
 

Other 

Receive all data at start-up 

If this setting is on, all data will be received from the connected microKORG XL+ when microKORG 
XL+ Sound Editor starts up. 
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 Menus 

microKORG XL+ Sound Editor (Mac OS X only) 

About microKORG XL+ Sound Editor 

Displays version information for microKORG XL+ Sound Editor. 

Preferences 

Displays the Preferences dialog box (→ p.22 "Preference settings"). 

Exit 

Exits microKORG XL+ Sound Editor. 

File 

New 

Creates new library data. 

New From Preset Data 

Creates new library data using preset data for microKORG, MS2000, MS2000B, etc. 

Open 

Loads library data from a library data file saved on your computer. 

Save 

Saves the currently edited library data to a library data file on your computer by overwriting the existing 
version of that file. 

Save As 

Saves the currently edited library data to a library data file on your computer with the name you specify. 

Import microKORG XL Library Data 

Reads the library data file (file extension “.mkxl_all”) for microKORG XL Sound Editor and creates new 
library data. 

Exit (Windows only) 

Exits microKORG XL+ Sound Editor. 

Edit 

Cut 

Cuts the selected program. 

Copy 

Copies the selected program. 
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Paste 

Pastes the cut or copied content into the selected program. 

Initialize 

Initializes the selected program. 

Revert to saved data 

Reverts the selected program to the state in which it was saved to the file. 

Communication 

Receive all data 

Loads all programs and global data from the microKORG XL+ into microKORG XL+ Sound Editor. 

Write all data 

Transmits all programs and global data from microKORG XL+ Sound Editor to the microKORG XL+ 
and writes it. 

Receive all programs / Receive global data 

Depending on the page shown in the library window, this command reads all programs or global data 
from the microKORG XL+ into microKORG XL+ Sound Editor. 

Write all programs / Write global data 

Depending on the page shown in the library window, this command transmits all programs or global data 
from microKORG XL+ Sound Editor to the microKORG XL+ and writes the data. 

Receive current program 

Reads the program currently selected on the microKORG XL+ into microKORG XL+ Sound Editor. 

Send to current program 

Transmits the program currently selected in microKORG XL+ Sound Editor to the microKORG XL+. 
This operation does not write the data into the microKORG XL+. 

Settings 

Show parameter values 

Shows the values of the knobs and sliders in the edit window. 

Preferences 

Opens the Preferences dialog box (->p.22 "Preference settings"). 

Window 

Open MIDI monitor window 

Opens the MIDI monitor window 

Open log window 

Opens the log window. 
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Previous program 

Edits the previous program. 

Next program 

Edits the next program. 

Close window 

Closes the window that is currently in the foreground. 

Help (Windows only) 

About microKORG XL+ Sound Editor (Windows only) 

Displays version information for microKORG XL+ Sound Editor. 
 

 Shortcut keys 

Menu items 
 

Menu item Windows Mac OS X 
New Ctrl + N command + N 
Open Ctrl + O command + O 
Save Ctrl + S command + S 
Save As Ctrl + Shift + S command + shift + S 
Cut Ctrl + X command + X 
Copy Ctrl + C command + C 
Paste Ctrl + V command + V 
Receive current program Ctrl + L command + L 
Send to current program Ctrl + T command + T 
Close window Ctrl + W command + W 

Library window 
 

Item Windows Mac OS X 
Show information editing 
dialog 

i i 

Show edit window Enter return 
Initialize selected program Delete delete 
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